ABC Graphics Suite

Congratulations and thank you for buying ABC Graphics Suite from Micrografx. This package offers superior
diagramming, flowcharting, illustration, clipart management, painting, and image editing tools for Windows 95.
ABC Graphics Suite integrates full version upgrades of the industry's proven best-of-breed graphics applications:
Designer, ABC FlowCharter, Picture Publisher and the new ABC Media Manager.

Designer 6.0 is the complete design and business communication tool for the Microsoft Office. Combined with its
new Office interface, Designer adds tremendous free-form graphics capabilities to the toolbox of the Office user,
without the significant learning curve other graphics tools would impose.

ABC FlowCharter 6.0 allows all business people to create a broad array of diagrams with easy and powerful
ready-to-use tools. FlowCharter provides Office users with a drag-and-drop environment which facilitates the
creation of popular structured business graphics from simple organizational charts to large, wall-sized process
maps.

Picture Publisher 6.0 is the fastest, easiest and most powerful image editor for Windows 95. Combined with its
new Office interface, Picture Publisher adds tremendous painting, image editing, and photo retouching
capabilities to the toolbox of the Office user.

ABC Media Manager provides drag-and-drop access to over 30,000 clipart, photo, and diagramming symbols. In
fact, ABC Media Manager is file independent. Users can now drag and drop all popular graphics files directly in
and out of ABC Media Manager. For example, if a user imports an IGES file into Designer, adds color and text to
it, the user can then drag the edited file directory into ABC Media Manager. ABC Media Manager recognizes the
format of the file and treats it as its own.

ABC Graphics Suite also includes ABC SnapGraphics 2.0 which allows the Office user to create any diagram with
the automated assistance of SnapLines, SnapShapes, and SnapText.

ABC Graphics Suite offers full 32-bit programs, ensuring you benefit from all Windows 95 32-bit operating system
attributes including long file names, multitasking, OLE 2.0, flat memory address support, and desktop shortcuts.

For further information on these applications, you can access their individual help files from the application's
Help menus.



Micrografx Software License Agreement (with Network Provisions)

This is a legal agreement between you (an individual or an entity), the end user, and Micrografx,
Inc. If you do not agree to the terms of this Agreement, promptly return the disk package and
accompanying items (including written materials and binders or other containers) to the place you
obtained them for a full refund.

License

1. Grant of License. This Micrografx Software License Agreement ("License") permits you to use one copy of
the Micrografx software product ("Software") on any single computer, provided the Software is in use on only one
computer at any time. If you have multiple Licenses for the Software, then at any time you may have as many
copies of the Software in use as you have Licenses. The Software is "in use" in a computer when it is loaded into
the temporary memory (i.e., RAM) or is installed into the permanent memory (e.g., hard disk, CD-ROM, or other
storage device) of that computer. However, a copy installed on a network server for the sole purpose of
distribution to other computers is not "in use." If the anticipated number of users of the Software will exceed the
number of applicable Licenses, you must have a reasonable mechanism or process in place to assure that the
number of persons using the Software concurrently does not exceed the number of Licenses. If the Software is
permanently installed on the hard disk or other storage device of a computer (other than a network server), then
the person authorized to use such computer also may use the Software on a portable computer, laptop, and
home computer. If such person's authorization to use such computer ceases for any reason (e.g. termination of
employment), then such person's authority to use the software on a portable computer, laptop, and home
computer shall cease.

2. Copyright. The Software is owned by Micrografx or its suppliers and is protected by United States copyright
laws and international treaty provisions. Therefore, you must treat the Software like any other copyrighted
material (e.g., a book or musical recording), except that you may either (a) make one copy of the Software
solely for backup or archival purposes, or (b) transfer the Software to a single hard disk provided you keep the
original solely for backup or archival purposes. You may not copy written materials accompanying the Software.

3. Other Restrictions. This License is your proof of license to exercise the rights granted herein and must be
retained by you. You may not rent or lease the Software, but you may transfer your rights under this License on a
permanent basis provided that you transfer this License, the Software and all accompanying written materials,
you retain no copies, and the recipient agrees to the terms of this License. You may not decompile, or
disassemble the Software. If the Software is an update, any transfer must include the update and all prior
versions.

4. Multiple Media Software. If the Software package contains both 3.5" and 5.25" disks, or other media, then
you may use only the media appropriate for your single designated computer or network server. You may not use
the other media on another computer or computer network, or loan, rent, lease, or transfer them to another user
except as part of a transfer or other use expressly permitted by this License.

Limited Warranty

5. Limited Warranty. Micrografx warrants that the Software will perform substantially in accordance with the
accompanying written materials and will be free from defects in materials and workmanship under normal use
and service for a period of ninety (90) days from the date of receipt. Any implied warranties on the Software are
limited to ninety (90) days. Some states do not allow limitations on the duration of an implied warranty, so the
above limitations may not apply to you. This limited warranty gives you specific legal rights. You may have
others, which vary from state to state.

6. Customer Remedies. Micrografx's entire liability and your exclusive remedy shall be, at Micrografx's
option, either (a) return of the price paid or (b) repair or replacement of the Software that does not meet
Micrografx's Limited Warranty and that is returned to Micrografx with a copy of your receipt. This Limited
Warranty is void if failure of the Software has resulted from accident, abuse, or misapplication. Any replacement
Software will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is
longer. Neither these remedies nor any product support services offered by Micrografx are available for this
U.S.A. version product outside the United States of America.



7. No Other Warranties. Micrografx disclaims all other warranties, either express or implied, including but not
limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the Software,
the accompanying written materials, and any accompanying hardware.

8. No Liability for Consequential Damages. In no event shall Micrografx or its suppliers be liable for any
damages whatsoever (including, without limitation, damages for loss of business profits, business interruption,
loss of business information, or other pecuniary loss) arising out of the use of or inability to use the Software,
even if Micrografx has been advised of the possibility of such damages. Because some states do not allow the
exclusion or limitations of consequential or incidental damages, the above limitations may not apply to you.

U.S. Government Restricted Rights

The Software and documentation are provided with Restricted Rights. Use, duplication, or disclosure by the
government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and
Computer Software clause as DFARS 252.227-7013 or subparagraphs (c) (1), (2) and (3) of the Commercial
Computer Software -- Restricted Rights at 48 CFR 52.227-19, as applicable, and any amendments thereto.
Contractor/manufacturer is Micrografx, Inc., 1303 Arapaho Rd., Richardson, TX 75081.

This Agreement is governed by the laws of the State of Texas.

For more information about Micrografx's licensing policies, please call Micrografx Customer Service at 1-800-733-
3729 or write: Micrografx Customer Sales and Service, 1303 Arapaho Rd., Richardson, TX 75081.

Revised 8/95



License Agreement: Frequently asked questions

" What is the significance of the Micrografx software license agreement? The license agreement is
the document under which Micrografx grants you, the end user, the right to use the software product. In addition to
the end user license agreement, your use is governed by the U.S. Copyright Act.

How has Micrografx changed its end user licensing policy? Micrografx has changed its end user
license agreement to simplify how its products are licensed for home, portables, and laptop use. Micrografx has
always provided concurrent usage to its customers and continues that in this agreement.

What does the license say? The underlying prlnaple of Micrografx's licensing policy has been and
continues to be that each use of a Micrografx product requires a license. Each license grants you the right to use
one copy of the software product on your computer. In addition, the license sets out the rules by which you may
"concurrently" use the product on a computer network, and grants you the right to make and use a second copy of
the product on a home and laptop computer in certain circumstances (described in more detail below).

" What is "concurrent use"? Software is "in use" on a computer when it is installed into the permanent
memory (typically, a hard disk, but including CD-ROM or other storage device) or loaded into the temporary
memory, or "RAM." On a network, a product may be used in either of two ways: (1) by installing the product on the
workstation's hard disk and running the software "locally," or (2) by installing the product off the server. With the
second option, the network server loads a copy of the software into the temporary memory, or "RAM," of the
workstation, but it is not stored in the workstation's permanent memory. This distinction is important when we later
discuss how to count the number of licenses needed for a computer network. "Concurrent use" occurs when one
copy of a software product is accessed from a network server and used by two or more nodes, or "workstations," on
that network. For example, a network of ten workstations has five "concurrent users" of a product if, at any one
time, a maximum of five workstations have the product loaded into temporary memory, and the remaining
workstations do not have the product loaded in either temporary or permanent memory. Note that the identity of
the five concurrent users may change over time, but in this example the maximum never exceeds five.

" How do | determine how many licenses | need for my company to comply with the Micrografx
license agreement? Starting with the principle that you need one license for each use of the product, there are
two basic rules that you need to follow in counting the number of "uses" of the product in your company. First, each
copy of the product that is installed on a hard disk or other storage device of a computer is a "use" that requires
one license. Second, if you plan to use the product on a computer network, and you have fewer licenses than the
total number of workstations, then you need to determine the maximum number of concurrent users of the product
you will have at any one time. The total number of "uses," arrived at by adding the number of copies that you will
have installed on hard disk plus the maximum number of concurrent users on a network, determines the number of
licenses you need.

" How do | determine the "maximum number of users" on my company's computer network? To
comply with the Micrografx license agreement, you must have adequate controls and mechanisms in place to
ensure that you have at least as many licenses as you have uses of the product at any one time. While there is no
single method that Micrografx requires or prescribes, you must have electronic or manual controls or procedures to
justify your calculation of the number of licenses. For example, there are electronic devices and software programs
that limit access to particular products running off a network server that would comply with this requirement (see
the next question about "electronic token" technologies). As an example of a manual method of making this
calculation, some companies periodically poll their users to determine how many employees never use the product,
and then simply purchase licenses for the remaining number of users.

" If 1 load the product on the hard disk of every workstation on the network, can I still count the
number of concurrent users so | don't have to purchase a license for every workstation? Is the answer
different if | use the so-called "electronic token" technology to limit the actual number of concurrent
users? No. And no. Loading the product onto the hard disk or other storage device of a network workstation is a
"use" that requires a license. It makes no difference if you have an "electronic token" system to regulate use. The
only way you may have fewer licenses than workstations on a network is when some of the workstations access the
product off the network server itself (i.e., the product is not stored on the workstation's hard disk) and you have
determined that less than all of the workstations use the product at any one time. Of course, if you transfer or
"download" the product from the server to a workstation's hard disk -- which requires one license -- you may later
completely delete the product off that hard disk to free up that one license for use elsewhere.

Do | need a separate license for the copy of the product on the server? No. You need not count the
server as one "use," provided that the server copy is merely accessed by the workstations connected to it and not
used separately.

" If | have a Micrografx application loaded into the temporary memory (RAM) of my network, but
it is iconized and not actively in use, is a license required? Yes. We consider that you are "using" one of our
products whenever it is loaded on your hard disk or in RAM. Thus, a program that is iconized requires a license
because it was first loaded into memory, or RAM. Remember, however, that unlike a product stored on a
workstation's hard disk (requiring one license), a product run off the server may be terminated or closed quickly,
freeing up that product license for use by another workstation on the network.

. Does Micrografx continue to allow end users to make a second copy of its application for home
and laptop use? Yes. If you have a Micrografx product loaded on the hard disk or other storage device of your
computer, then you may make a second copy for home and laptop use. The principle here is to allow you to use the
Micrografx product even when you are away from work, either at home or while traveling. However, this does not
apply to products that are loaded on the network server. (Some companies have their own restrictions on home
software use, so you may need to check with your systems administrator on this topic.)

" Is this Micrografx license a site license? If not, how does it differ? This Micrografx end user license



is not a site license because each use requires a separate license. In a "site license," a company is given unlimited
rights to internal use of a software product for a flat fee.

For additional copies of this Micrografx Software License Agreement, contact: Micrografx, Inc.,

Attn: Legal Department, 1303 Arapaho Rd., Richardson, Texas 75081.

Information in this document is subject to change without notice and does not represent a commitment on the
part of Micrografx, Inc. The software described in this document is furnished under a license agreement. The
software may be used or copied only in accordance with the terms of the agreement.



Copyright and Trademark Statements
Copyright

Copyright © 1995 by Micrografx, Inc. All Rights Reserved. No part of this publication may be reproduced,
transmitted, stored in a retrieval system, or translated into any language in any form by any means without the
permission of Micrografx.

Micrografx, Inc.

1303 Arapaho

Richardson, TX 75081

Sales and Marketing: 214-234-1769
Trademark acknowledgments

Micrografx, the Micrografx logo, Picture Publisher, and ABC FlowCharter are registered trademarks and ABC
Graphics Suite, ABC Media Manager, Micrografx Designer, Designer for 0OS/2, Draw for 0OS/2, Charisma, Graphics
Works, PhotoMagic, and Micrografx ClipArt are trademarks of Micrografx, Inc.

Adobe, Adobe Type Manager, ATM, PostScript, and Adobe Illustrator are registered trademarks of Adobe Systems,
Inc.

Ares Software Corporation is the copyright owner of portions of this software. © Ares Software Corporation. All
Rights Reserved.

AutoCAD is a registered trademark of Autodesk, Inc.

Classic PIO Partners and Classic Photographic Image Objects are trademarks of Classic PIO. Copyright © Classic
PIO Partners. All Rights Reserved. Images made in the USA.

CompuServe is a registered trademark of CompuServe, Inc.

First Impressions® is a registered trademark and Formula Onem and Visual Componentsw are trademarks of
Visual Components, Inc. Copyright © 1994-95 Visual Components, Inc. All Rights Reserved.

GEM and Artline are registered trademarks of Digital Research, Inc.
Hewlett-Packard is a registered trademark of Hewlett-Packard Company.

IBM is a registered trademark of International Business Machines Corporation.
IMSI CAD Symbols® copyright © 1995 IMSI, Inc. All Rights Reserved.

ImageStream w Graphics and Presentation Filters copyright © 1991-1995 ImageMark Software Labs, Inc. All
Rights Reserved.

International CorrectSpellw English spelling correction system © 1994 by INSO Corporation. All rights reserved.
Reproduction or disassembly of embodied algorithms or database prohibited.

Kodak and the Photo CD logo are trademarks of Eastman Kodak Company.

LG Images copyright © 1995 Landis & Gyr, Inc. All Rights Reserved.

Macintosh is a registered trademark and TrueType is a trademark of Apple Computer, Inc.

Microsoft and MS-DOS are registered trademarks and Windows is a trademark of Microsoft Corporation.
Paintbrush is a trademark of ZSoft Corporation.

PANTONEe® * Computer Video simulations used in this product may not match PANTONE-identified solid color
standards. Use current PANTONE Color Reference Manuals for accurate color.

*Pantone, Inc.'s check-standard trademark for color.



"PANTONE Color Computer Graphics" © Pantone, Inc. 1986, 1988.

Pantone, Inc. is the copyright owner of PANTONE Color Computer Graphics and Software, which are licensed to
Micrografx, Inc., to distribute for use only in combination with ABC Graphics Suite. PANTONE Color Computer
Graphics and Software shall not be copied onto another disk or into memory unless as part of the execution of
ABC Graphics Suite.

PANTONE®, PANTONE MATCHING SYSTEMe, and PANTONE Process Color Systeme are registered trademarks of
Pantone, Inc.

PhotoDiscm Sampler Images copyright © 1995 PhotoDisc, Inc.

Pictures NOW!w is a trademark of Wood River Gallery. Copyright © 1994 Wood River Gallery. All Rights Reserved.
Windows Draw® and Windows OrgChart are trademarks of their respective owners.

WordPerfect and DrawPerfect are registered trademarks of WordPerfect Corporation.

Other products mentioned are trademarks or registered trademarks of their respective companies.

This commercial computer software and documentation are being provided to the government with RESTRICTED
RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph
(C)(2) of FAR 52.277-19 or subdivision (c)(l)(ii) of DFAR 52.227-7013.

Bitstream Oz Handicraft, Bremen, Dutch, Mister Earl, Swiss, and Zurich are trademarks of Bitstream Inc. Blippo
and Handel Gothic are trademarks of FotoStar International. Futura is a registered trademark and Allegro, Bauer
Bodoni, and Lucian are trademarks of Fundicion Tipografica Neufville SA. Aurora and Shadow are trademarks of
Johannes Wagner. Lydian is a registered trademark and Ad Lib, American Text, Americana, Balloon, Bank Gothic,
Bernhard Fashion, Bernhard Modern, Broadway, Brush Script, Caslon 540, Caslon Bold, Caslon Openface, Century
Schoolbook, Cheltenham, Commercial Script, Copperplate Gothic, Della Robbia, Dom, Franklin Gothic, Goudy Old
Style, Hobo, Huxley Vertical, Kaufmann, Latin Extra Condensed, Onyx, Parisian, Park Avenue, Stencil, Tango,
Thunderbird, and Wedding Text are trademarks of Kingsley-ATF Type Corporation. Playbill is a registered
trademark and Windsor is a trademark of Stephenson Blake & Company Ltd. Amazone and Libra are trademarks
of Tetterode Nederland (Lettergieterij Amsterdam). Orbit-B is a trademark of Visual Graphics Corporation.
Bitstream Oz Handicraft, Bremen, Dutch, Mister Earl, Swiss, and Zurich are trademarks of Bitstream Inc. Blippo
and Handel Gothic are trademarks of FotoStar International. Futura is a registered trademark and Allegro, Bauer
Bodoni, and Lucian are trademarks of Fundicion Tipografica Neufville SA. Aurora and Shadow are trademarks of
Johannes Wagner. Lydian is a registered trademark and Ad Lib, American Text, Americana, Balloon, Bank Gothic,
Bernhard Fashion, Bernhard Modern, Broadway, Brush Script, Caslon 540, Caslon Bold, Caslon Openface, Century
Schoolbook, Cheltenham, Commercial Script, Copperplate Gothic, Della Robbia, Dom, Franklin Gothic, Goudy Old
Style, Hobo, Huxley Vertical, Kaufmann, Latin Extra Condensed, Onyx, Parisian, Park Avenue, Stencil, Tango,
Thunderbird, and Wedding Text are trademarks of Kingsley-ATF Type Corporation. Playbill is a registered
trademark and Windsor is a trademark of Stephenson Blake & Company Ltd. Amazone and Libra are trademarks
of Tetterode Nederland (Lettergieterij Amsterdam). Orbit-B is a trademark of Visual Graphics Corporation.

IEC- and ISO-standard symbols included on the CD-ROM are copyrighted by the International Electrotechnical
Commission (IEC) and the International Organization for Standardization (ISO), respectively. Neither IEC nor ISO
accept responsibility for the accuracy of their respective symbols reproduced by Micrografx.

The IEC- and ISO-standard symbols included on the CD-ROM have symbol names according the numbers used for
the individual symbols in the published IEC or ISO standards. As the symbol names do not include the actual
description of the symbols, it would be handy to have the printed standards to work with.

To order the printed standards for the IEC- and ISO-standard symbols included on the CD-ROM, please contact
one of the following organizations.

International Electrotechnical Commission International organization for
(IEC) Standardization (IS))

3, rue de Varembé 1, rue de Varembé



P.O. Box 131

CH-1211 Geneva 20
Switzerland

Tel. (+41) (0) 22 734 0150

Fax (+41) (0) 22 733 3843

For both IEC and ISO symbols in the United
States, contact:

American National Standards Institute
(ANSI)

11 West 42nd Street
New York, NY 10036
Attn: Customer Services
Tel. (212) 642-4900

Fax (212) 302-1286

P.O. Box 56

CH-1211 Geneva 20
Switzerland

Tel. (+41) (0) 22 749 0111

Fax (+41) (0) 22 733 3430

For both IEC and ISO symbols in the United
Kingdom, contact:

BSI Standards

Linford Wood

Milton Keynes MK14 6LE
United Kingdom

Tel. 0908 221166

Fax 0908 322484

Please note that IEC 617 is similar to IEEE 315, 315A, 91, and 91A.

Please note that IEC 617 corresponds to BS 3939, ISO 3511 corresponds to BS 1646, ISO 4066 corresponds to BS
4466, 1SO 4067 (parts 1, 2, and 6) corresponds to BS 1192 (part 3), and ISO 6284 corresponds to BS 1192
(partl).



Network Installation of ABC Graphics Suite

For information on installing ABC Graphics Suite on a network, double-click the Netread.hlp icon on the root of
the application CD-ROM from Windows Explorer. This help file gives detailed installation instructions for use by
network administrators.



Uninstalling ABC Graphics Suite

You can uninstall either an application (e.g., Picture Publisher) or the entire ABC Graphics Suite package from
your hard drive.

1 Click the Start button, and point to Settings.
2 Click Control Panel, and double-click the Add/Remove Programs icon.

3 Highlight the application(s) you want to remove or highlight Micrografx ABC Graphics Suite if you want to
delete the entire package.

4 Click Add/Remove and follow the instructions on your screen.



Contacting Technical Support

Micrografx offers a number of technical support services for ABC Graphics Suite. Please call (214) 234-2694 for
further information regarding free and fee-based support options, fax support and online services.



Contacting Micrografx through Online Services

Micrografx maintains forums on America Online, CompuServe and the Microsoft Network for Technical Support
inquiries, requests, and new product information and updates. Locate keyword MGX on America Online, type GO
MICROGRAFX on CompuServe or type GO MGX on the Microsoft Network to access the most helpful Technical
Support in the industry. (Not available for the 30-day trial version.)

In addition, you can contact Micrografx through our Web site on the Internet. Our Web address is
http://www.micrografx.com.



Resolving Problems with Specific Printers

. Objects do not crop, TrueType fonts print with a square opaque white background, or lines
show through text when printing to an HP Paintjet printer. Update to the latest version of the HP Paintjet
driver.

" Bitmaps printed to the HP Desk]et printer repeat the image or are rotated incorrectly. Update to
the latest version of the HP Desk]et driver.

. Bitmaps printed to the HP 550C printer are extremely dark and oversaturated, or do not print
correctly. Update to the latest version of the HP 550C driver.

" OLE objects from earlier versions of Micrografx products (Designer 3.1 and earlier, Charisma
2.1 and earlier, Draw 3.0 and earlier) do not print to a PostScript printer. Export the object from the earlier
version of the Micrografx product, then import it into Designer 6.0.

" Printing a Designer drawing to a Level 1 PostScript printer, a piece of one corner of a rectangle
is missing. This happens when you create an EPS file in Designer and put the EPS image into certain programs. To
fix it, on the Registry tab of the Options dialog box, add the Value Name EnablePSAdapt to the Mgxgre key, and
give it a numeric value of 0. Then set the options of the printer driver to EPS. Print. Print to EPS and use the new
file.
" Printing to an AutoGrafix device, there is a white line at the top of the 35 mm slide. When
printing to 35 mm slides, choose a page size of Use Printable rather than 35mm in the Page Setup dialog box. Also,
choose Center on Page in the Print Document dialog box.



Troubleshooting

What is the problem?

{button ?,JI("',"IDH_QA_No_lIcon')} | can't find the icon. How can | run the program?

{button ?,JI("',"IDH_QA_Not_all_fonts')} Why don't | have all the fonts?

{button ?,JI("',"IDH_QA_How_much_disk_space')} How much disk space is required to install ABC Graphics Suite?

{button ?,JI(*',"IDH_QA _Toolbar_buttons')} Why are ABC Graphics Suite toolbar buttons on Excel's toolbar after |
uninstalled?

{button ?,JI(*',"IDH_QA_Exchange')} Why isn't the Send option working in my application?



I can't find the icon. How can | run the program?

You can run any of the programs in ABC Graphics Suite by clicking the Start button on the Windows 95 Taskbar.
On the Start menu, point to Programs and then click the name of the program (such as Micrografx ABC
FlowCharter).

You also can create a shortcut to the program. To learn how, click the Start button on the Windows 95 Taskbar.
On the Start menu, click Help. In the Help Topics dialog box, click the Index tab and type the word "icon." In the
second list, double-click "creating icons for your programs."



The Media Guide lists several fonts | can use, but they aren't available to me.
Why don't | have all the fonts?

To install individual features, choose the Custom Installation option. This option lists each feature such as filters,
fonts, and ClipArt, which allows you to customize your software or to add features not previously installed.

You can install additional fonts, also, through Control Panel.
Insert the application CD-ROM in the drive.

Click Start, point to Settings and click Control Panel.
Double-click the Fonts icon.

On the File menu, click Install New Font.

Select your CD-ROM drive in the Drives drop-down list.
Double-click the Fonts folder in the Folders drop-down list.

Highlight the fonts you want to install or click Select All to choose all the fonts.
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Click Ok.



How much disk space is required to install ABC Graphics Suite?

During installation, each option you select should display the amount of disk space required to completely install
your selection. If the amount of disk space shown is not enough to install your selection, clear off more disk
space or change to a location on your hard drive where more disk space is available.



Why are my ABC Graphics Suite toolbar buttons still on the Excel toolbar after |
uninstalled ABC Graphics Suite?

There is a known problem with Microsoft Excel 7.0 where toolbar buttons that are deleted programatically (like
ABC Graphics Suite's uninstaller) don't stay deleted. If you see ABC Graphics Suite buttons on the toolbar after
having unistalled, perform the following steps:

Run Microsoft Excel.
Place the cursor on the Excel toolbar and click the right mouse button.
Select the Customize menu item. The Customize dialog box displays.

Position the cursor over the button you want to delete on the toolbar.
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Click the left mouse button and drag the button off the toolbar, releasing the left mouse button when the
button outline is off the toolbar.

6 Repeat steps 4 and 5 for every button you want to delete.



Why isn't the Send option working in my application?

If you've installed MSMail 3.0 mail client software on your system after uninstalling Microsoft Exchange, you can't
use the Send option in ABC Graphics Suite applications. You should use Microsoft Exchange as the mail client
software on your Windows 95 system rather than MSMail 3.0.



Updated import and export filters

Source Ext
Adobe Illustrator Al .ai
AutoCAD Drawing .dwg
AutoCAD DXF .dxf
CompuServe Bitmap .gif
Computer Graphics Metafile .cgm
Corel Clipart Format .cmx
CorelDRAW! 3.0, 4.0, 5.0 .cdr
Digital Research GEM .gem

Encapsulated PostScript/Al EPS .eps

HP Graphics Language .hgl
HP Graphics Language .plt

IGES Drawing .igs

JPEG File Interchange .Jjpg
Kodak Photo CD .pcd
Macintosh PICT .pct
Micrografx Drawing .drw

Micrografx Picture Publisher 4.0 .pp4

Micrografx Picture Publisher 5.0 .pp5

Micrografx Picture Publisher .ppf
PC Paint .pcx
PostScript .prn
PostScript .ps
Scitex CT .sct
Sun Raster .ras
Tagged Image File Format Liff
Targa Bitmap tga
Windows Bitmap .bmp
Windows DIB .dib
Windows Enhanced Metafile .emf
Windows Metafile .wmf
WordPerfect Graphics 1.0, 2.0 .wpg
Note
" This is the entire list of all supported filters. If you don't see the filter you want in your ABC Graphics Suite

application, choose the Custom installation option from the installer and select the desired filter(s).






ABC Graphics Suite Read Me

GLOBAL

" Fully qualified filenames over 128 characters may not be detectable or accessible by some applications
within the ABC Graphics Suite. This includes many file types including application components, data files, clipart,
palettes, etc. If this occurs, make sure the filename (including the path) is less than 128 characters.

. ABC Graphics Suite doesn't support CMYK JPEG images. Although most CMYK JPEG images will produce a
"not supported" message, some images will cause the application to stop responding.
. You can add TrueType fonts directly from the CD-ROM. Open the Windows Control Panel and choose Fonts.

From the File menu choose Install New Font. Select the CD-ROM drive letter and the Fonts folder on the CD as the
path to locate fonts. In the list box, choose the fonts to add to your system and click OK.

PICTURE PUBLISHER
" To use the Send Binary PostScript option in the Print dialog, you must also have Tagged binary

communications protocol checked in the Advanced dialog of the PostScript Tab located in the printer’s Properties
dialog. You can only set this option from Control Panel or Printers (in the Settings flyout of the Start menu).

. Some PhotoShop compatible plug-ins may cause the application to stop responding when used in a Batch
Macro.

" Regenerating Andromeda plug-ins through the Command List may cause your system to stop responding.
. Andromeda plug-ins may cause your application to stop responding if the masked area is much wider than
it is tall.

" Andromeda Series 3 plug-ins are incompatible with the version of MSVCRT20.DLL installed with Picture

Publisher 6.0. As a result, the filter won’t display. Contact Andromeda for information on obtaining a compatible
version. Once a compatible version is located, place it in your Plugin directory and the Filter will work.

" Alien Skin 2.0 plug-ins may cause your application to stop responding if the Object selected doesn’t fill up
the Alien Skin preview window. In addition, some of these plug-ins may not work on masked areas. Contact Alien
Skin for upgrades to correct these problems.

. The Picture Publisher Image Viewer only works if you install Quick View. To install Quick View, go to Control
Panel, run Add/Remove Programs, and change to the Windows Setup Tab. Select Accessories, click Details, and
select Quick View in the Components list box. To use the Picture Publisher Image Viewer, right-click on a file type
supported by Picture Publisher in the Explorer and select View from the right mouse menu.

Tablet Pressure Sensitivity is not supported in this release.

" For more information on Kodak Color Management, please contact Kodak for their book "Managing Color
W|th Micrografx Picture Publisher." You can reach Kodak at (800) 752-6567.

The Scan... command is no longer supported. Scanning is now supported through TWAIN and the Acquire...
command. Contact your scanner manufacturer for information on TWAIN support for your scanner. TWAIN drivers
included with Picture Publisher 6.0 are the most current drivers available at the time of shipping. Contact Hewlett-
Packard through CompuServe or your scanner manufacturer to find out about the availability of updated drivers.

" You can only run Picture Publisher special effects on images greater than 256 colors. If the Image\Effects
menu is grayed out you must first convert the image to an RGB by going to the menu Image\Convert to\RGB color.
Registry entries

" You can change these items in the Registry under HKEY_CURRENT_USER\Software\Micrografx\Picture
Publisher\6.0\Settings to modify the program's behavior.

To turn off hi-resolution rebuild when you paste low-resolution data into a hi-resolution image, change the
following entry in the Registry:

NoHiResRebuild=0
to
NoHiResRebuild=1

You can disable the warning dialog box for read-only files. Picture Publisher defaults to warning dialog boxes
appearing when you try to open or save to a read-only file. You can modify the following entry in the Registry
file to do this:

WarnReadOnly="Number’
'Number' can either be 1, the default, which is ON, or 0, which is OFF.

Windows NT specific

The Use Printer Screening option in the Print dialog causes the image to print incorrectly in NT. The image
will print correctly if this option is turned OFF.

ABC FLOWCHARTER
To access ABC OLE Automation help using Excel

1 Run Excel.
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On the Insert menu, click the Macro command.
Choose Module.
On the Tools menu, click the References command.

Click Browse. Search for the abcauto.tlb file where ABC Graphics Suite is installed and select it. (eg. "C:\
Program Files\Micrografx\ABC Graphics Suite\ABC FlowCharter\ABCAUTO.TLB"

Click ABC OLE Automation so an X appears in the box in front of it.

Click OK to close the dialog box.

On the View menu, click the Object Browser command.

Click the down arrow to the right of the Libraries/Workbooks text box.

Click ABC FlowCharter to select it.

Click the object you want information about in the Objects/Modules list box.

Click the button with a question mark in it, if you wish. ABC OLE Automation help appears showing the topic
about that object.

or

Click the method or property you want information about in the Methods/Properties list box. A short
explanation appears at the bottom of the dialog box.

Click the button with a question mark in it. ABC OLE Automation help displays the topic about that method
or property.






